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The Opening Menu Screen 
 

 
 

 
This opening menu screen contains all the links to the various parts of the database ς use the 
mouse to point to the relevant button and click.   

 
 Button  Action  

 
 Incidents  Opens the main database for inputting or reviewing incident data 

 
 Incident Analysis   Opens the data analysis section of the database 

 
 Utilities   Opens the utilities area for maintaining lists and modifying 

existing incident data 
 

 Behavioural Risk  Opens the behavioural risk area for inputting and processing risk 
assessment information 

 
 PI Analysis  Opens the PI analysis area for analysis of physical interventions 

and de-escalation strategies 
 

 User Guide  Opens this user guide on screen (assuming you have Microsoft 
Word installed on your computer)  

  
 Close database  Closes the database and exits Microsoft Access 
  

Closing a window 

 
Throughout the database, the close button at the foot of the screen will close the current 
window and take you back to the previous screen. 
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Utilities 
 

The Utilities button on the menu screen takes you to the utilities area of the database: 

 

 

Lists 
 

The buttons in the List area each allow for the maintenance of lists from which selections may be 
made when recording the details of an incident.  The recurring event descriptions and time lists 
provide the row and column headings used on the recurring incident form and report.  
 
In each case: 

To delete an item from the list 

Click on the square to the left of the list item in order to select it, and then press the Delete 
key on the keyboard.  Confirm the deletion when prompted. 

To add to the list 

Click in the empty box at the bottom of the list and type your entry.  Next time you open 
the list, the new entry will have been re-sorted into its correct order. 

To modify a list entry 

Highlight the text using the mouse then re-type. 
 
You cannot add or delete recurring event headings but you can change the descriptions or leave 
unwanted headings blank by deleting the text within the heading. 

 



Behaviour Support Database User Guide Page 6 
 

Installation 
 

This allows you to change the establishment name that appears on the menu screen. 
 

Amend data 
 

This button allows you to amend any incident data you have already input, by opening the amend 
screen. You will need to know the incident reference of the incident you want to change ς see 
ά±ƛŜǿƛƴƎ LƴŎƛŘŜƴǘǎέ ōŜƭƻǿΦ 
 
 

 
 

Select the incident for amendment by either typing the incident reference in the Incident to 
Amend box, or by clicking the arrow to the right of the box and scrolling down to select the incident 
you want to amend.  
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Main Database: Clients 
 
The Incidents button opens the main area of the database for maintaining a list of clients. 

 

 
 
This screen provides an alphabetical list of current and former clients, and serves as an index to the 
incidents recorded against that client. It also allows you to maintain records of Achievements and Rewards. 
The Risk column indicates which clients are currently selected for risk assessment ς this is described in a 
later section. 
 

To add a client 
 

The Add Client button at the foot of the screen will move the cursor to an empty row at the 
bottom of the list of names.  Click in the empty row and type the client information.  Next time you 
open the client list, the new entry will have been re-sorted into its correct alphabetic order. Each 
client will be automatically allocated a Client ID reference which uniquely identifies each client 
within the database ς this is the blue number at the right of the row. 

 

To delete a client 
 

Click on the grey square to the left of the client name in order to select the record, and then press 
the Delete key on the keyboard.  Confirm the deletion when prompted.  Take care - be aware that 
this action is not reversible, and you will lose the incident data associated with the deleted client 
record. 

 

To modify client information 
 

Highlight the text using the mouse then re-type. 
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To view or record an incident involving a client 
 

Click the Incidents button alongside the relevant client record to open the incident screen.  See the 
next section for an explanation of this feature. 

 

To view or record Achievements or Rewards for a client 
 
Click the Achievements button alongside the relevant client record to open the incident screen.  
See page 16 for an explanation of this feature. 

To add notes to a client record 
 

Click the Notes button alongside the relevant client record to open the Notes dialogue box.  This 
allow for virtually unlimited free format notes to be stored for any individual client.  To delete all or 
part of a note, select the text and use the Delete key on the keyboard.  
 

 
 
Additional pieces of information are provided for in the client notes box (see illustration above). 
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To find a client record 
 
Use the Find button at the foot of the screen to search for a client record.  Clicking it opens 
the Find Record dialogue box.   
 

As an example of its use, to find a record by searching for a particular surname, first click anywhere in 
the Surname column then click the Find button. 

 
1. Alongside Find What: type all or 

part of the surname you are 
searching for. 

 
2. Ensure that Look In: is set to 

surname. 
 

3. Set Match: to: 

 Whole Field if you have 
typed in the full surname 

 Start of Field if you have 
just typed in the first few characters of the surname 

 Any Part of Field if you have typed in a few characters which are not necessarily the first few 
letters of the surname 

 
4. Leave Match Case unticked so that capital letters are irrelevant to the search; ignore Search Fields 

as Formatted. 
 

5. Click Find Next to find the first record matching your search criteria ς if that is the correct one, click 
Cancel otherwise Find Next to search for another. 

 
The same principles apply when searching on any of the fields of information throughout the database. 

 

To print a list of clients 
 

Clicking the Print List of Clients button will create an alphabetical list of clients.  You will be prompted 
to enter: 

 C for current clients only 

 L for clients who have left 

 Or A for all 
 
bƻǘŜ ǘƘŀǘ άƭŜŦǘέ clients are defined as those having a Left Date on their record: those with the date left 
blank are deemed to be current clients. 
 
The list will be previewed on screen and may be printed by clicking on the File menu and choosing 
Print.  The preview screen may be closed by clicking on the File menu and choosing Close. 
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Adding incidents 
 
New incidents may be added by clicking the Add an Incident button at the foot of the screen, then using 
the Find Client search box to find the relevant client.  Clicking on the arrow will open a scrolling list of 
clients ς scroll down to the name you require then and click on it to select the client.   
 
 

 
  
 
From that point onwards the procedure for viewing or inputting data is much the same, so refer to the next 
section.  Note that once incident data is input it cannot be altered from this screen.  If a change is necessary 
you need to enter the Utilities area of the database described on page 5.   
 
The incident input screen has an Undo button.  That will clear the screen of information you have input for 
the current incident allowing you to back out if, for instance, you find you have insufficient information to 
complete the record.  Clicking either the Close button, the Add Another button to start inputting another 
incident, or closing the window will commit and secure the information you have input. 
 
Each incident will be automatically allocated an Incident Reference which uniquely identifies each incident 
within the database. 
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Viewing Incidents 
 
Existing incident records for an individual client can be viewed by finding the client in the client list and 
clicking the Incidents button to open the incidents screen. 
 

 
 
 
The incidents are listed in date order, latest on top. View an incident by clicking the View Incident button. 
Print Incident creates a report of the incident and previews it onscreen allowing you to then print it. As the 
report includes a date and time, it is suggested that a report be produced for each incident and filed to 
create a data audit trail. 
 
The Print All Incidents for Client button creates a report of each incident for the client, and is useful when 
preparing material prior to a review meeting. 
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The Incident Record 
 

 
 

¦ǎƛƴƎ άŘǊƻǇ-Řƻǿƴέ ƭƛǎǘǎ 
 
Much of the information may be selected from pre-defined lists.  The content of these lists is maintained 
using the List buttons on the Utilities menu, as previously described.  
 

In each case, there are three options: 

 To click the arrow at the right-hand 
edge of the box to reveal a 
scrolling list ς click on the required 
entry to select it 

 To type in the first few characters 
of the required choice ς once 
enough has been typed, the 
database will complete the 
selection for you 

 To type in all of an item  
 

Multiple entries 
 
Some of the data items allow for multiple entries.  
When inputting the incident, new entries may be 
made in the empty box at the bottom of the input 
area, if necessary using the scroll bar at the right in 
order to get there.   This empty box is not visible 
when viewing an existing incident.  
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Recurring incidents 
 

 
 

This is designed to allow a count of recurring incidents throughout the day, without the need to 
input each one as a separate incident.  It is recommended that an analysis sheet is used in class to 
keep a count of the incidents, and to form the basis of the input. 
 
Clicking the Recurring Event Analysis button on the Clients screen allows an analysis to be viewed 
and printed for an individual client between a range of dates. 
 
The column timeslot settings and row descriptions can be modified from the Utilities menu ς you 
may use up to twelve rows and twelve columns. 
 

Achievements and Rewards 
 

 
 

This area of the database allows for one-line listings of achievements and rewards. The category and staff 
member concerned are selected from lists. 
 

 
 

 
A button at the bottom of the screen allows a report to be printed for an individual client.
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Data Analysis 
 
A key feature of the database is the ability to analyse the incident data in many different ways.  Two 
mechanisms exist for doing this.  One is solely to use the database itself ς a flexible query / data filter 
module has been integrated into the database to enable the data to be interrogated using various criteria, 
 
However it is possible by means of a single mouse-click to create a worksheet of selected incident data 
suitable for further analysis in Microsoft Excel.  This enables the production of charts, creation of pivot 
tables, utilisation of the database functions of Excel, and more sophisticated statistical investigation. 
 
Both these options are briefly described in the following paragraphs, and with practice they will be seen to 
be a very flexible enquiry tool. 
 

In the Database 

 
To illustrate the capabilities, the following examples show the principles of interrogating the database; the 
specific examples used here can be adapted to suit many different situations. 
 

Using the Data Analysis module 

 
Click the Data Analysis button on the menu to enter the data query area of the database.  Note 
that from this point onwards you will be working on extracted incident records.  Whilst in this area 
of the database, any warning messages about modifying or deleting records only apply to the copy 
of the data being used to generate your reports.  The main data will remain unaffected by these 
actions so a wrong choice is quite easily rectified! 
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Clear existing data 

 
If necessary, clear the previous query by clicking the Clear Extracted Data and Start Again button 
to clear the form. 
 

Example 1: all incidents within a range of dates 

 
Click the By Date Range button and, when prompted, supply the From and To dates to define the 
date range.  The form will now be populated with the records matching the date criteria specified.  
Dates are in the format dd/mm/yy ς i.e. 1/2/06 = 1st February 2006. 
 
Variations are to select incidents by Client ID, Other Client Present, Activity, Location,  Staff 
Member Involved or Other Staff Present ς in each case click the appropriate button.  With any of 
these selections you will be prompted for From and To dates. 
 

9ȄŀƳǇƭŜ нΥ ŀƭƭ ƛƴŎƛŘŜƴǘǎ ǿƛǘƘ ƭƻŎŀǘƛƻƴ ƻŦ άDȅƳέ or άtƭŀȅƛƴƎ CƛŜƭŘέ 

 
Firstly use the By Location button ŀƴŘ ǿƘŜƴ ǇǊƻƳǇǘŜŘΣ ƪŜȅ ƛƴ άDȅƳέ and then the date range.  To 
add to the list, click the By Location button ŀƎŀƛƴ ŀƴŘ ǘƘƛǎ ǘƛƳŜ ƪŜȅ άtƭŀȅƛƴƎ CƛŜƭŘέΦ  ¸ƻǳ Ŏŀƴ 
continue building up the list in this way using any of the Add to List buttons. 

 

Counting and Reporting 

 
Having built up the list, buttons at the foot of the screen allow you to either count or print a report 
of the selected incidents.  If you click Report, you will be prompted to supply some text as a 
descriptive report heading to later identify the contents of the report.  The More Reports button 
will take you to any customised reports provided for your installation. 
 

Filtering the selection 

 
Having built up the list, for example by date range or member of staff, it is then possible to filter it 
down to only retain records meeting a particular set of criteria.  To do so, click the Filter List 
button.  You will now see a further set of buttons representing the various attributes by which it is 
possible to filter the list.  Click the appropriate button and, when prompted, supply the necessary 
selection criteria. 
 
See the screen shot overleaf for the full list of filter criteria. 
 
You can apply a succession of filters, for instance by time, then maybe filter the list further by 
activity, then perhaps by location.  
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If you have performed multiple extracts, it is possible to extract duplicate incidents. The Remove 
Duplicate Incidents button excludes them from the analysis. Likewise, the other buttons exclude 
non-current clients and sensitive incidents. 
 

Example 3: the incidents from example 2, applying a Gender filter 

 
Following on from example 2, click Filter by Gender and, when prompted, key άMaleέ.  The filtered 
records will now be displayed.  Buttons at the foot of the screen give you two choices: 
 

 Revert to Previous List:  to abandon this filter and revert to the unfiltered list, orΧ 

 Apply Filter: in which case your original list will be replaced by the result of the filter (you 
can always clear the selection and start again if you make the wrong choice).  

 
It is then possible to apply a new filter to the remaining records, to further refine the selected 
incidents. 

Filtering to current clients 

 
By default, incident records included will be both current and left clients.  The Current Clients Only 
button applies a filter to only include those without a date left. 

Duplicate incidents 

 
If you have built up your list by multiple selections, then it is possible that some records may have 
been picked up twice because they matched more than one set of criteria. The Filter Duplicate 
Incidents button removes duplicated records. 
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These examples are merely illustrative of the types of questions that can be answered with a 
little ingenuity in the selecting and filtering.  Remember the basic principle: add to the list until 
you have every record that could possibly apply, and then use the filters to refine it down to 
those that meet the particular set of circumstances. 
 

 

Clearing the selection 

 
At any stage you can click the Clear Extracted Data and Start Again button to clear the form and 
start again ς no harm will be done to the main database records. 

 

Removing individual records from the selection 

 
Clicking to place a tick in the box on the left of the incident record will mark records which you wish 
to manually delete from the list: they will be removed when you click the Remove Ticked Records 
button ς be assured that you are NOT deleting them from the database, only from your selection. 

 

Viewing the incident detail 

 
/ƭƛŎƪƛƴƎ ǘƘŜ ά±ƛŜǿέ ōǳǘǘƻƴ ƻƴ ǘƘŜ ǊƛƎƘǘ ƻŦ ǘƘŜ ƛƴŎƛŘŜƴǘ ǊŜŎƻǊŘ ǿƛƭƭ ŜƴŀōƭŜ ȅƻǳ ǘƻ ǾƛŜǿ ǘƘŜ ŘŜǘŀƛƭǎ ƻŦ 
that particular incident. 

 

Exporting to Excel 

 
The Export to Excel button allows for the creation of a Microsoft Excel format worksheet 
containing your selected data, which is described more fully in the next section. 
 

Exiting Data Analysis 

 
The Close button at the bottom right of the screen returns you to the menu. 

 

In Microsoft Excel 

 

Export to Excel 

 
/ƭƛŎƪƛƴƎ ǘƘŜ ά9ȄǇƻǊǘ ǘƻ 9ȄŎŜƭέ ōutton offers four choices ς see next page. 
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1. Export Incidents, exporting one incident per worksheet row 

2. Export Antecedents exports incident data and each antecedent ς this might result in multiple 
worksheet rows per incident if there is more than one recorded antecedent 

3. Export Behaviours exports incident data and each behaviour ς this might result in multiple 
worksheet rows per incident if there is more than one recorded behaviour 

4. Export Interventions exports incident data and each intervention ς this might result in multiple 
worksheet rows per incident if there is more than one recorded intervention 

 
With each of these options, you will be prompted for a filename. If the chosen filename already 
exists, you will have a choice of using another name or overwriting the existing Excel file. 

 

 
Please note that if you intend to overwrite an existing file and that file is open, then the Export to 
Excel feature will not work. If that happens, close the workbook file in Excel (using File ς Save As to 
save it under a different name if you wish to keep the data) then try exporting again. 
 

 
 

Example of worksheet 

 
An example of an Excel file of incidents is illustrated overleaf. 
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Excel functionality 

 
Users will greatly benefit from a working knowledge of Microsoft Excel, and familiarity with the 
Chart, Subtotal, Sort, AutoFilter and Pivot Table features.  This is beyond the scope of this User 
Guide but some help may be gleaned from the examples that follow.   
 
Note that these examples are all using standard functionality of Microsoft Excel. 

 ######! 

 
A row of hashes [#####] in an Excel worksheet indicates that the column needs to be widened in 
order to display the correct data. 

 

Example 1: a chart of the selected incidents by month 

 
This illustrates the use of the Subtotal and Charting capability of Excel. 
 
 
In the database, select the data (perhaps by 
date range), filter as required then export 
to Excel.  The data will be automatically 
exported in date order, so no further 
sorting will be required in Excel. 
 
Once in Excel, apply subtotals by clicking 
anywhere within the data area and 
choosing SubtotalΧ from the Data menu. 

 
Choose to Sum the Count column at every 
change in Month, and click ok.  Widen 
column B (the Month column) as necessary 
ς see the sample overleaf. 
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Select level 2 by clicking on the small [2] button. 
 
Select the block of data in the Month and Count columns, 
excluding the Grand Total. 
 
Press the F11 key on the keyboard to create a chart.  
Options on the Chart menu allow you to change the chart 
type and alter the appearance of the chart. 

 Use the Chart Type and Chart Options  
 

 

 

 

 

 
 
To return to the data, click the Export to Excel tab at the foot of the worksheet.  To remove the 
subtotals, choose {ǳōǘƻǘŀƭǎΧ on the Data menu and click Remove All. 
 
To delete a chart, right-ŎƭƛŎƪ ƻƴ ƛǘΩǎ ǘŀō ŀǘ ǘƘŜ Ŧƻƻǘ ƻŦ ǘƘŜ ǎŎǊŜŜƴ ŀƴŘ ŎƘƻƻǎŜ Delete. 
 
To print a chart, with the chart displayed on screen, click the Print button or choose Print from the 
File menu. 

 

Example 2: using AutoFilter in Excel 

 
 

Microsoft Excel has its own filtering capability, enabling you to experiment with the data by filtering 
according to any of the available criteria. 
 
Turn the feature on by clicking on the Data menu, choosing Filter then AutoFilter.  The same 
sequence of commands will turn the feature off again. 

 
Each of the column headings now has an arrow indicating a drop-down list.  In the example above, 
the Gender filter is being used to select only the Female records.  The selection can be restored to 
all records by selecting (All) from the list. 
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Example 3: Pivot Tables 

 
A PivotTable report is an interactive table that quickly combines and compares data.  You can 
rotate its rows and columns to see different summaries of the source data, and you can display the 
details for areas of interest.  The actual means of producing a pivot table differ between versions of 
Excel but for those familiar with, or who want to experiment with, Pivot Tables, the following may 
serve as an example. 
 

 
The above table was arrived at by: 

1. Selecting the whole block of data 
2. From the Data menu, choosing Pivot Table Report 
3. !ƴǎǿŜǊƛƴƎ ǘƘŜ ǉǳŜǎǘƛƻƴǎ ŀǎƪŜŘ ƻŦ ǘƘŜ tƛǾƻǘ ¢ŀōƭŜ ²ƛȊŀǊŘΧ 

a. ¢ƻ ǎŜǘ ǘƘŜ Řŀǘŀ ŀǎ ά/ƻǳƴǘέ 
b. To set the column ŀǎ ά[ƻŎŀǘƛƻƴέ 
c. ¢ƻ ǎŜǘ ǘƘŜ Ǌƻǿ ŀǎ άDŜƴŘŜǊέ 
d. To create a new worksheet 

 
Here is a more complex example: 

 
 
 
 
 
 
 
 
 
 
 
 

Lƴ ǘƘƛǎ ŎŀǎŜΣ ǘƘŜ ŎƻƭǳƳƴǎ ƘŀǾŜ ōŜŜƴ ǎŜǘ ǘƻ άaŜƳōŜǊ ƻŦ {ǘŀŦŦ tǊŜǎŜƴǘέ ŀƴŘ άDŜƴŘŜǊέΤ ǘƘŜ Ǌƻǿǎ ǘƻ 
ά!ŎǘƛǾƛǘȅέ ŀƴŘ [ƻŎŀǘƛƻƴέΤ ǘƘŜ Řŀǘŀ ƻƴŎŜ ŀƎŀƛƴ ƛǎ ά/ƻǳƴǘέΦ 

 
Hopefully, from these examples, the usefulness of Excel Pivot Tables as a powerful data analysis 
tool can be appreciated. 
 

 

 Location     

Gender Classroom Farm/allotment Gym Outside play area Grand Total 

Female 1 1 1  3 

Male 2   1 3 

Grand Total 3 1 1 1 6 

 

    Female   
Female 
Total Male   Male Total Grand Total 

Activity Location AC CC VP  AB AC ShC   

Art/Craft Classroom   1 1  1 1 2 3 

Art/Craft Total     1 1  1 1 2 3 

Dance Gym  1  1     1 

Dance Total    1  1     1 

Leisure/Play Outside play a     1   1 1 

Leisure/Play Total       1   1 1 

Working on farm Farm/allotment 1   1     1 

Working on farm 
Total   1   1     1 

Grand Total   1 1 1 3 1 1 1 3 6 
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PI /De-escalation strategy analysis 

 
 

Step 1: extracting the incidents where intervention data has been input 

 
When yoǳ ŎƭƛŎƪ ǘƘŜ {ǘŜǇ м ōǳǘǘƻƴΣ ȅƻǳ ǿƛƭƭ ōŜ ǇǊƻƳǇǘŜŘ ŦƻǊ άŦǊƻƳέ ŀƴŘ άǘƻέ ŘŀǘŜǎ ǘƻ ŘŜŦƛƴŜ ǘƘŜ 
date range ς they could be for a week, term or any other appropriate period. Records of incidents 
between these dates will be extracted. 
 
 

Step 2: view reports 

 
A range of reports can be viewed by clicking on the relevant buttons ς they are all based on the 
information extracted in step 1. 
 
 

Step 3: export to Excel 

 
The Step 3 button causes the extracted records to be copied to an Excel workbook for further 
analysis. 
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Behavioural Risk 
 

Important note 
 

This is intended as a brief description of the functionality but it is recommended that those 
intending to use these features first receive some specific training in risk assessment techniques. 
 
Information about this can be obtained from: 
 

Jon Hull 
Hull Consultants 
61 Sunnyside 
Newhall 
Swadlingcote 
Derbyshire 
Telephone 07973 377893 
Email j.hull@virgin.net 

 
 

 
 
 


